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About this Document
RAILROAD & CO. is the leading product line of computer programs for digitally or conventionally controlled model railroads. It contains the following members:
• TrainController™ is the world's leading software for model railroad computer control.
• TrainProgrammer™ is the program, which makes programming of DCC decoders
as simple as a few clicks with your mouse.
• +SmartHand™ is the world's premium handheld railroad control system designed
for computer controlled model railroads.
• +4DSound™ is a module, that recreates realistic spatial sound effects for each model railroad layout controlled by TrainController™ without the need to install onboard sound into each decoder.
• +Street™ is a module for control of car systems with TrainController™.
• +Net™ is a module, that allows to control your layout with a network of several
computers running TrainController™.
The Editions of TrainController™
TrainController™ is offered in three variants:
• TrainController™ Bronze provides a low-cost entry into computer controlled
model railroads. It is primarily designed for users with small and medium size layouts and average requirements. Novice users, who do not know TrainController™,
may consider doing their first steps with TrainController™ Bronze. The reduced
functionality of this variant makes it easier to identify and to learn the basic functions
of TrainController™.
• TrainController™ Silver is the successor of the established and well-known version TrainController™ 5. It addresses users with high demands and also users, who
are not reluctant to puzzle to accomplish individual goals.
• TrainController™ Gold is the flagship of the TrainController™ family and in a
class of its own. TrainController™ Gold is primarily designed for users with supreme requirements, who want to operate their layout like the real professionals.
While TrainController™ Silver is already able to operate even very large layouts,
TrainController™ Gold provides much more convenience, efficiency and security
for design and operation – especially for larger layouts.
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RAILROAD & CO. TrainController™ 9 Bronze Change Description
This document provides an overview of the features, which are unique in
TrainController™ 9 Bronze and which distinguish TrainController™ 9 Bronze from
TrainController™ 8 Bronze. It is mainly intended for users, who know
TrainController™ 8 Bronze, and who want to learn about the differences between
Version 9 and 8. It is assumed, that the reader is familiar with TrainController™ 8
Bronze and its Users Guide. New users of TrainController™ 9 should focus on the
TrainController™ 9 Bronze Users Guide rather than this document.
The numbers of the particular chapters and sections of this document are inherited from
the concerning chapters and sections of the TrainController™ 9 Bronze Users Guide.
This allows readers, who are familiar with that Users Guide, to implicate the contents of
both documents. This is also the reason for the gaps occurring in the numbering.
The new Functions at a Glance
In the following all new functions of TrainController™ 9 Bronze are listed. Outstanding improvements are marked with an * .
Misc:
1.
2.
3.
4.
5.
6.

*** New user interface with Ribbon as known from the current Microsoft Office
versions (see page 8, “User Interface: Ribbon vs. Menus and Tool Bars)
More than 30 new user interface designs (see page 9, “User Interface Design”).
Specific design with the possibility to adjust the primary colors of the user interface
to personal taste.
Multiple windows of the same type (e.g. all train windows) can be closed simultaneously with a single call of a menu command.
Floating windows can be easily maximized or half-screen docked to the boundaries
of each computer screen by drag & drop with the mouse (page 10).
Improved, HTML based tool tips with text formatting and images.

Hardware and Digital Systems:
7.
8.

The complete functionality provided by +Hardware Version 8 is available in the
TrainController™ core product.
The Info button in the Connection tab of many objects displays help information
about the currently selected digital system.
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Switchboard:
9.

* Smart gate symbols for control of the gates of engine sheds or other gates passed
by trains (see page 11).
10. * Crossing gate symbols with own intelligence for control of the crossing gates at
single- or multi-track railway crossings (see page 11).
11. Text elements can contain more than one line of text.
Dispatcher and Automatic Operation:
12. Improved User Interface for AutoTrain by Drag and Drop (see section 5.13)
13. Improved calculation of the block diagrams of schedules: paths in dependent schedules are recreated accordingly in many cases, when blocks have been inserted or deleted in the switchboard.
14. Waiting Times in blocks of schedules are specified as real-time data (see page 18).
Inspector Window:
15. The current display status (e.g. whether a certain category is currently collapsed or
expanded) is maintained as far as possible, when the focus changes to another object.
16. Detailed display of engine functions.
17. Display of the rules for spontaneous runs for each vehicle.
18. Extended display of schedule properties: general settings, start and destination operations, rules, details of successors, etc.
19. List of all sections of a schedule including the schedule specific section settings.
Since these settings are only displayed, if they are different from their default, it is
easily possible to determine those sections, where non default section settings have
been made.
20. The list of schedules, which contain the current block or route, includes the details
of the schedule specific schedule section sections for this block or route and each
schedule.
Message Window and Pins:
21. *** Pins (see chapter 8.1, “Pins”)
+SmartHand™ Mobile:
22. Full and individual customization of the switchboard view (colors, track styles,
highlighting, grid style, grid size, etc.) for each particular mobile device.
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23. The driving mode currently selected in the train view is applied to AutoTrain runs.
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1 Introduction

1.3

Fundamentals of Use

User Interface: Ribbon vs. Menus and Tool Bars
The user interface of TrainController™ is either controlled via the Ribbon known
from the current versions of Microsoft office or via menus and toolbars as in the previous versions of TrainController™ (classic user interface).
Ribbon:
All the commands in the new user interface are organized into logical groups on a series
of tabs called the Ribbon. The Ribbon provides an accessible interface to rich functionality that TrainController™ provides.
When you start TrainController™ 9 for the first time, you will notice that the Ribbon
has replaced the old style menus and toolbars. Think of the Ribbon as a set of "resultsoriented" tabs.
Each tab of the Ribbon is like a rich toolbar organized around a high-level task and contains commands for accomplishing that task. The Track tab, for example, contains the
frequently-used commands for editing the track layout in the switchboard, while the Operation tab includes commands for operation of the model railroad. When a tab is selected, the commands associated with it become visible in the upper part of the screen.
The commands on each tab are ordered into groups to further organize the available features. For example, the Edit tab includes groups of commands called Undo, Clipboard,
Train, Schedule, etc.
You will find all the traditional file menu commands under the File menu button left of
all tabs in the top left corner of the Ribbon.
Classic User Interface:
The File menu also provides a command, which allows to change to the classical user
interface with menus and tool bars known from the previous versions of
TrainController™ for users who prefer the old style.
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Quick Access Toolbar:
Everyone has a set of commands they use most often, so it is possible to add commands
to the Quick Access Toolbar, a small toolbar positioned in the title bar of the application window. The Quick Access Toolbar provides a location for heavily-used commands that need to be available with one click (regardless of the current Ribbon state).
You can add any item to the Quick Access Toolbar. From then on you can access the
command from wherever you are in the application, and avoid situations where you need
to repeatedly switch between Ribbon tabs to accomplish repetitive tasks.

Diagram 1: Ribbon

Diagram 2: Classic User Interface

User Interface Design
In addition to the user interface styles known from previous
TrainController™ 9 provides more than 30 new user interface designs.

versions

. Among others the following styles are new in version 9:
•
•
•
•
•
•

Several Office 2013 styles
Visual Studio 2015, 2013 and 2012
Windows 10, Windows 8 and Windows 7
Railroad & Co. 9, 8 and 7
Several extra styles
A custom style with the possibility to adjust the primary colors of the user interface
to personal taste.
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Window Handling
Floating windows can be maximized or half-screen docked to the boundaries of each
computer screen. Maximizing and docking as well as later normalizing and undocking
can be performed with the mouse by drag & drop (similar to the Aero Snap feature
known from the current versions of Microsoft Windows).
In this way a floating switchboard and a floating dispatcher window, for example, can be
easily arranged on top of each other by drag & drop with the mouse, each covering half
of the computer screen.
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2 The Switchboard

2.3

Drawing the Track Diagram

Smart Gates and Crossing Gates
Gates are smart switchboard symbols, which can be used for automatic control of the
gates of engine sheds or all other gates, which can be passed by trains.
To work properly, a gate must be attached to a straight element or a curve element in the
switchboard. The gate is automatically opened, if a route passing this track symbol is activated. The gate is automatically closed again, if this route is deactivated.
By using conditions it is possible to influence the operation of gates furthermore.
Crossing gate symbols can be used for automatic control of crossing gates. Crossing
gates can expand over more than one switchboard cell. To work properly, the switchboard cells covered by a crossing gate must contain at least one straight element or curve
element. The crossing gate is automatically closed, if a route passing one of these track
symbols is activated. The gate is automatically opened again, if the last active route
passing the crossing gate is deactivated.
The latter covers proper control of multi-track railway crossings. Even if two trains pass
the railway crossing at the same time, the crossing gates remain closed, until the last
train has left the crossing and cleared the route across the crossing.

Diagram 3: Crossing Gates and multi-track Railway Crossing

The above picture series shows the crossing gates at a multi-track railway crossing,
which are automatically closed, when the first route passing over the railway crossing is
activated, and opened again, when the last route is deactivated.
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5 The Visual Dispatcher I

5.13 AutoTrain – Start of Schedules made Easy
AutoTrain™ is another outstanding feature of TrainController™. With AutoTrain™
you can run automatic trains at any time during operation without the need to define
schedules in advance.
Auto Train by Drag & Drop
The fastest way to run AutoTrain™ is Drag & Drop with the mouse:
• Select the Operation tab (or the Schedule menu in the classic user interface) and
call the AutoTrain by Drag and Drop command.
• Move the mouse cursor to the start block.
• Press and hold the left mouse button on one of the following symbols:
, if you want the train to exit the start block to the left.
, if you want the train to exit the start block to the right.
• Hold the left mouse button pressed and drag the mouse to the block in the block diagram or in the switchboard, where the train will stop.
• Release the left mouse button over one of the following symbols:
, if you want the train to enter the destination block from the right to the left.
, if you want the train to enter the destination block from the left to the right.
• The train will now start and run automatically to the destination block.
Some additional options are available:

Click this option, if you want to leave the AutoTrain by Drag and Drop command turned on after releasing the mouse button. In this case another AutoTrain run can
be initiated by drag and drop without the need to call the AutoTrain by Drag and Drop
command once more.
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8 The Message Window and Pins

8.1

Pins

Pins are an outstanding and unique feature of TrainController™. Pins make error diagnostics and debugging significantly easier and much more intuitive by showing information, where the events happen, rather than in a plain list like in the message window.
Thereby troubleshooting becomes literally much more targeted.
Pins are an important expression of our aspirations to make train operations not only as
realistic as possible, but also to make the path to this goal as easy and intuitive as it can
be.
Pins are displayed in different types and colors on the computer screen with small markers.
Pins can be made visible with commands in the Pins group of the View tab of
TrainController™. While pins are visible, the color of the windows, where pins are
displayed, is being changed to gray scale. Thereby it is easier to locate the pins.
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Diagram 4: Display of a pin in the Dispatcher Window

By clicking on the marker of a pin the pin can be expanded and collapsed. An expanded
pin shows a window, which displays the information of this pin.

Diagram 5: Expanded pin in the Dispatcher Window

Diagram 4 shows an active schedule, which contains the blocks “Southtown 1” and
“Southtown 2” at the bottom. The train chooses “Southtown 1” for a certain reason and
a yellow pin is displayed in block “Southtown 2”. If you want to know, why the train did
not choose “Southtown 2”, click to the pin. The pin is expanded and displays the reason
(Diagram 5): “Southtown 2” was not choosen, because its entry was locked.
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This is a very simple example, but in more complex situations you will come to appreciate, that important information is displayed, where the events happen.
There are the following types of pins:
• System pins
• Dr. Railroad pins
• User pins
System Pins
System pins are automatically created by TrainController™ during the operation of the
layout. In many cases system pins are created together with the messages, which can be
made visible in the message window. But there are also many pins, which do not have a
corresponding message.
System pins are implicitly filtered to the context of the window, where they are displayed. By selecting a certain train in the switchboard or dispatcher window, for example, only the systems pins associated with this train are displayed. The diagram of a
schedule in the dispatcher window, for example, displays only the pins which were generated by the execution of this schedule. System pins can also be filtered explicitly to the
pins generated in the current session or during the most recent execution of a schedule.
These features support the focus on the key information for the current debugging.
System pins are displayed in three colors:
• Red / Error:
Red pins appear, if a certain operation fails, e.g. the execution of a schedule.
• Yellow / Warning:
Yellow pins appear, if a certain operation is performed with limitations or another
operation is chosen instead.
• Green / Ok:
Green pins indicate the successful execution of operations. Green pins can be used,
for example, to track the path of a train under control of a schedule.
The display of green pins is turned off by default to allow you to focus on possible
problems.
The diagram below shows the same situation like Diagram 4, this time with the display of green pins turned on. The path chosen by the train is clearly visible now.
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Diagram 6: Green pins marking the path of a train in the Dispatcher Window

Dr. Railroad Pins
The information generated by Dr. Railroad can be made visible with pins, too. These
pins correspond to Dr. Railroad errors and questions, which are normally displayed in
the message window. Dr. Railroad pins appear at the location of erroneous objects on
the computer screen.
Dr. Railroad pins are displayed in two colors:
• Red / Warning
• Yellow / Question
User Pins
User pins can be created by the end user. After selecting an object on the computer
screen and creating a user pin a marker appears at the location of this object. The text,
which belongs to each user pin, can be freely edited.
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User pins are displayed with blue color. They can be deleted at any time and are stored
in the project file.
User pins are very useful to leave notes for further processing of the data for the end user himself or other users.
If an end user has to interrupt editing of data of a specific object, for example, he can
create a user pin for this object with a note, what to do next, when the work is continued.
If an end user has a problem with the execution of a certain schedule by a certain train,
and wants to consult an expert user, for example, he can create one or more user pins
with details about his problem, e.g. for the block of the schedule, where the train is currently located, leave these pins expanded, store the project file and send the file to the
expert user. When the expert user opens the project file, the user pins showing the location as well as the detail information of the problem will become visible in expanded
state on the screen at once. This is a significant improvement for the exchange of relevant information in such cases.
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Appendix

Migrating Existing Data Files from TrainController™ 8
Project files generated with TrainController™ 8 are automatically converted into the
format of the new version when opened in TrainController™ 9. The following things
should be noted, however.
Waiting Times in Blocks of Schedules
Waiting Times in blocks of schedules are specified in TrainController™ 9 as real-time
data. Existing data, which was scaled by the speed of the fast clock in previous versions,
is adapted accordingly.
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